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1. Preface: Gecko Gripper Technology 
 
The Gecko Gripper is a robot gripper that uses gecko-inspired adhesion to pick up flat objects 
without an air system.  
 

1.1. Gecko Gripper Nomenclature 
 

 
Figure 1. Gecko Gripper Nomenclature. 

 
The gripper design features a structural base that also encompasses the sensing and control 
electronics. The top of the structural base is the mounting face, which is physically mounted on 
the robot. Opposite the mounting face, the gripping face presents four gripper pads arranged 
in a 2x2 grid that perform the adhesion action. The pads have a proprietary adhesive gripping 
technology that enables the gripper to efficiently attach and lift flat and smooth objects without 
an air system. The gripper pads are removable and can be fully replaced as part of a 
recommended routine maintenance schedule. The gripping face also contains an ultrasonic 
sensor that monitors an object’s presence. The front face of the gripper base displays four (4) 
LEDs that display information about the gripper’s state. The three (3) connectors for gripper 
power, communication, and power for the optional autonomous piezoelectric cleaning system 
are located on the right side of the gripper base.  Power (24V) is supplied through the I/O 
connector. Data is passed via either the Ethernet connector (8 pins) or the I/O connector (10 
pins). 



1.2. How the Gecko Gripper Works 
 
The Gecko Gripper attaches to flat and smooth object surfaces through the same 
mechanism used by an actual gecko (van der Waals forces). This is accomplished through 
contact with adhesive pads in a preload-hold-detach fashion.  
 
The gripper creates adhesion by preloading the pads with a small force normal to the 
object’s surface.  

 
Figure 2 Gecko Gripper placement on substrate (left) and applying a preload force, compressing the pads (right). 

 
After preloading, the gripper can hold and move the object with no additional force 
application.  

 
Figure 3 The gripper can lift the substrate. 

As specified by the robot protocol, the gripper will detach from the object by withdrawing 
the pads into the gripper housing. The gripper pads are reusable and do not leave “sticky” 
residue on surfaces. The pads will wear out over time (dependent upon the object’s 
material) and can be easily replaced using the pad replacement tool. Furthermore, the 



gecko-like pad technology enables the gripper to attach and detach on fast timescales (e.g. 
detachment 500msec).  

 
Figure 4. The Gecko Gripper retracts the adhesive pads in order to detach from the substrate. 

 

1.3. Overview of Key Operating Principles  
 
Because of the Gecko Gripper’s unique mechanism of action, it is important to understand 
the following key operating principles to use the gripper correctly and to achieve optimal 
gripper performance.  This is VERY important. 

 

• Surface Roughness Affects Gripping  
The Gecko Gripper works best with highly polished surfaces that allow for maximal 
contact between the adhesive pads and the substrate surface. As the surface becomes 
less smooth, more preload force is required to grip substrates. Matte surfaces should be 
considered the maximal surface roughness limit which the gripper is able to grip.  
See Section 8.4 for further information. 
 

• Environmental Conditions Affect Gripping 
The adhesive pads use van der Waals forces to attach to a substrate. If there is dust or 
debris on the substrate surface, the pads will interact with these particles instead. 
Dusty, greasy, oily, or wet substrates will not adhere to the Gecko Gripper. The Gripper 
works best with clean, smooth, and dry surfaces.  
See Section 8.5 for further information. 

 

• Preload Force Determines Maximum Payload Force 
The adhesion force is also dependent on the amount of preload force applied to the 
surface. This preload force also depends on the surface smoothness or roughness. A 
minimum threshold of preload force is required to grip and move any payload. The 
payload force then increases with a corresponding increase in preload force. Finally, 
payload force is also saturable at some preload force specific to the material and 
operating conditions.  

 See Section 8.4 for further information. 



 

• Reconcile Gripper Function with Robot Collision Detection or Other Safety Systems 
When using the Gecko Gripper with a robot in position control, care must be taken 
during the gripping phase of the object as to not trip off the robot’s collision detection 
system.  The most force the gripper will ever need to exert on an object is 150N for 
maximal adhesion.  Based upon your robot type and object, it may be necessary to 
adjust the robot’s collaborative or collision settings to preclude tripping off the robot 
upon contact.  

 

• Pick Location and Object Moments Can Overcome Gripping Force 
Gripper adhesion specifications assume that the center of gravity of the object is 
equidistant from the gripper pads. If the center of gravity of the object is not centered 
or moments are applied to the object, robot-object movement can decrease the 
adhesion force of the gripper causing it to drop the objects. 

 See Section 8.5 for further information.  
 

• Pads will Wear Out 
Over time, the gecko pads will wear and require replacement.  There is no deterministic 
way to determine how worn the pads are, so the user must be mindful of the pad 
change-out interval.  This will depend on the environment in which the pads are used.  
While pad wear cannot be measured, a dropped part can be detected, and the robot 
informed of the event.  The “pad wear” LED will also light up, informing the user that 
action is required.  
See Section 7.1, 7.2 and 10 for further information. 

 
 

  



2. Safety 
 
The Gecko Gripper is a piece of industrial equipment, intended as an end-effector or tool for 
industrial robots. It is intended for pick and place operations of flat, smooth objects. Misuse can 
cause damage to the Gripper or the connected equipment.  
 

2.1. Validity and Responsibility 
 
The information in this manual is not a guide to design a complete robotic application. The 
safety instructions are limited to the Gecko Gripper only and does not cover the safety 
precautions of a complete application. The complete application must be designed and 
installed, in accordance with the safety requirements specified in the standards and 
regulations of the country where the application is installed.  
 
The application integrators are responsible for ensuring that the applicable safety laws and 
regulations in the country concerned are observed and that any significant hazards in the 
complete application are eliminated.  
 
This includes, but is not limited to:  

• Making a risk assessment for the complete application.  

• Validating that the complete application is designed and installed correctly.  
 
 

2.2. Limitations of Liability 
 

The safety instructions and other information in this manual is not a guarantee that the user 
will not suffer injury, even if all instructions are followed.  
 
 

2.3. Warnings in this Manual 
 

DANGER! This indicates a very dangerous situation which, if not avoided, could 
result in injury or death.  

 
CAUTION This indicates a potentially hazardous situation which, if not avoided, could 

result in injury or damage to the equipment.  
 

NOTICE  This indicates additional information such as tips or recommendations.  
 
 
 



2.4. General Warnings  
 
This section contains general warnings regarding use of the Gecko Gripper. 
 

1. Make sure that the Gripper is properly mounted. 
 

2. Make sure the Gripper does not collide with obstacles. 
 

3. Never use a damaged Gripper. 
 

4. Make sure not to have any limbs in contact with or between the Gripper housing 
and mounting face when it is operating or in teach mode. 
 

5. Make sure to follow the safety instructions of all equipment in the application. 
 

6. Never modify the Gripper! A modification might cause dangerous situations. 
 

7. OnRobot A/S DISCLAIMS ANY LIABILITY IF THE PRODUCT IS CHANGED OR MODIFYED 
IN ANY WAY. 

 
8. When mounting external equipment, make sure that the safety instructions both 

herein and in the external manual are followed. 
 

9. If the Gripper is used in applications where it is not connected to a UR robot, it is 
important to make sure that the connections resemble the analogue input, digital 
inputs, outputs and the power connections. Make sure you use a Gecko Gripper 
programming script that is adapted to fit your specific application. For more 
information, please contact your supplier. 

 
10. When the Gripper is combined with or working with machines capable of damaging 

the Gripper, it is highly recommended to test all functions separately outside the 
potentially hazardous workspace. 
 

11. When the Gripper feedback (I/O ready signal) is relied upon for continues operation 
and a malfunction will cause damage to the Gripper and/or other machines, it is 
highly recommended to use external sensors in addition to the Gripper feedback for 
insuring correct operations even if a failure should occur. OnRobot A/S cannot be 
held responsible for any damages caused to the Gripper or other equipment due to 
programming errors of the Gripper. 
 

12. Never let the Gripper come in contact with corrosive substances, soldering splashes, 
or abrasive powders as they may damage the Gripper.  
 



13. Observe collaborative standards if personnel stand within the operating range of the 
Gripper. 

 
14. Never operate the Gripper if the machine on which it is fitted does not comply with 

safety laws and standards of your country. 
 
 

2.5. Intended Use 
 
The Gripper is industrial equipment intended as an end-effector or tool for industrial robots. 
It is intended for pick and place operations of a variety of different objects. 
 
Collaborative use of the Gripper, with humans close to or within the work area, is only 
intended for non- hazardous applications, where the complete application, including the 
object, is without any significant risks according to the risk assessment of the specific 
application. 
 
Any use or application deviating from the intended use is deemed to be impermissible 
misuse. This includes, but is not limited to: 

1. Use in potentially explosive environments.  
2. Use in medical and life critical applications.  
3. Use before performing a risk assessment. 

 
 

2.6. Risk Assessment 
 
It is important to make a risk assessment. Because the Gripper is considered partly 
completed machinery, it is also important to follow the guidelines in the manuals of all 
additional machines in the application. OnRobot A/S recommends that the integrator uses 
ISO 12100 and ISO 10218-2 guidelines to conduct the risk assessment. 
 
The integrator should consider the following potentially dangerous situations when 
performing the risk assessment. There may be additional dangerous situations depending 
on the specific situation or application. 

1. Entrapment of limbs between the Gripper and substrate. 
2. Penetration of skin by sharp edges and sharp points on the grabbed object. 
3. Consequences due to incorrect mounting of the Gripper. 
4. Objects falling out of the Gripper, e.g. due to incorrect gripping force or to high 

acceleration from a robot. 
 

  



3. Getting Started: Contents 
3.1. Gecko Gripper 

 
Figure 5 CAD drawing of the Gecko Gripper and pads. 



 

3.2. Parts List 
 

Part Name Description 
Gecko Gripper V5 Gecko Gripper, Version 5 
Gecko Gripper Pad 
Assembly, 1 set of 4 pads 

Gecko Gripper Pad Assembly, 1 set 
of 4 pads 

Turck Cable - 10 wire, I/O 

Cable, 10-wire, Double-ended cord 
set, straight female connector to 
straight male connector, M12 
Eurofast connectors 

Turck Cable - 8 wire Ethernet 
RJ45 

Cable, 8-wire, Ethernet, Male, M12, 
5M 

Gripper Mounting Bolts 
M6X1.0 80mm Length SS Socket 
Head Cap Screw 

Hex Key - 5mm for mounting 
robot, 9" overall length 

Hex Key - 5mm for mounting robot, 
9" overall length 

Gecko Pad Removal Tool 

Blade Putty Knife, 1-1/4" Wide x 
0.075" Thick Blade with Beveled 
Edge 

OnRobot A/S USB Drive - 
user guides & GUIs USB Stick - user guides & GUIs 
AC/DC DESKTOP ADAPTER 
24V 90W AC/DC DESKTOP ADAPTER 24V 90W 

Quick Start Guide  
 

Table 1 Parts list for Gecko Gripper and optional additions. 

 

3.3. Gecko Gripper Software 
 

User interface software for configuring and operating the Gecko Gripper can be 
downloaded from either the accompanying OnRobot A/S USB flash drive or from the 
OnRobot A/S website: 

 
https://onrobot.com/products/gecko-gripper/ 

  

https://onrobot.com/products/gecko-gripper/


4. Quick Start Guide  
 

Safety Reminders 
Installation and operation of the Gecko Gripper should be performed by trained 
professionals only. 
 
DANGER Improper handling of the gripper and its parts while 

connected could result in injury or death. 
 

STEP 1: Install Pads and Mount Gripper  
Install the four Gecko Gripper pads by inserting them into the gripping face of 
the gripper. The Gecko Gripper uses two screws (M6-1-80) to mount directly to a 
Universal robot. Otherwise, a mounting plate must be used (for other robot 
brands). Use the 5mm hex key to insert and tighten in the bolts to 8 Nm.  

 
 

STEP 2:  Power Gripper  
The Gecko Gripper is powered through the I/O cable.  

 
Upon powering up, the gripper’s blue Comms light will blink twice after a slight 
delay to indicate that the gripper has completed its power-on sequence. It is 
now recommended that you test all the gripper functions using the Windows 
Desktop GUI. 
 
A 4-pin connector is also attached to the gecko gripper but is only used for 
internal troubleshooting. 

 
 
STEP 3: Install Gecko Gripper GUI  

Install the Gecko Gripper Windows Desktop GUI from the supplied USB flash 
drive or the OnRobot A/S website. 

 
 

STEP 4:  Set Gripper Parameters 
We recommend using the robot-agnostic Desktop GUI to test gripper 
functionality and program the gripper. This easy-to-use interface allows you to 
specify several gripper parameters that designate a gripper state. 

 
 

STEP 5:  Operate Gripper 
You can operate the Gecko Gripper through two different communication 
modes: Digital I/O and Ethernet TCP. Using these modes, you can create a fully-
customized gripping protocol tailored to your needs.  



5. Installing the Gripper on the Robot  
 
Mounting the gripper on the robot is a quick and simple process. For all Universal Robots 
models, the gripper can be mounted directly to the robot and does not require the mounting 
plate. For other robot models, a mounting plate or other adapter is required. 
 

5.1. Required Supplies, Tools, & Equipment 
 

Assemble the following supplies, tools, and equipment prior to installation: 
 

Parts 
Gripper components. 

✓ Gecko Gripper V5 
✓ Gecko Gripper Pad Assembly 
✓ Turck Cable, 10-wire, I/O 
✓ Turck Cable, 8-wire, Ethernet RJ45 
✓ Gripper Mounting Bolts (M6-1-80) 
✓ OnRobot A/S USB Drive containing user 

guides and GUIs 

Supplies 
Consumables. 

✓ Zip ties (recommended) 
✓ Mounting plate for alternate robot 

models (optional) 

Tools 
Required for installation or repair but not 
operation. 

✓ Hex key, 5mm (included) 
✓ Gecko Pad Removal Tool (included) 

 

Equipment 
Required for operation. 

✓ AC/DC Desktop Adapter 24V 90W 
(included) 

✓ 24V DC power supply 
 

Table 2 Installation Materials.  

 

5.2. Mechanical Installation: Mounting the Gripper 
 

5.2.1. Parts List  
The following parts are included in the Gecko Gripper delivery: 

✓ Gecko Gripper 
✓ Gecko Gripper Pad Assembly 
✓ Mounting Screws x2 
✓ Hex key, 5mm (for mounting gripper) 

 
 
 
 



5.2.2. Safety notices:  
 
DANGER!  Improper installation can lead to damage to the gripper, 

robot, materials, or bodily harm or death to operators. Make 
sure that the gripper is installed correctly by a trained 
professional. 

 
CAUTION Ensure that the robot is powered off or is stationary (not running a 

program) prior to installing the gripper. 
 

5.2.3. Procedure for Mounting the Gripper 
 
For Universal robots, proceed to Step 2 as no mounting plate is required. 
 
Step 1: Install the Gecko pads on the gripper prior to installing the gripper on the 

robot.  
 

 
Figure 6 The Gecko Gripper gripping face where the four pads will be inserted. 

 
Attach the four (4) Gecko Gripper pads to the gripping face by aligning 
the notch in the mounting hole with the reciprocal tab on the pad 
assembly.  
 



 
Figure 7 Notch in mounting hole (left) and tab on pad assembly (right). 

 
 
 

 
Figure 8 Aligning the pad assembly for insertion into the mounting hole. 

 
 
The strong magnets of the pad attachment system will help pull the pads 
into place. Once installed, they should be completely flush with the 
surface of the gripper’s mounting face.  
 



 
Figure 9 Installing the final pad on the gripper. Notice that the silver plate of 

 each the installed pad is flush with the gripper housing. 

 
Step 2: Attach the mounting plate to the robot using two mounting screws (M6-

1-80). Tightened each screw to 8 Nm using a 5mm hex key.  
This step is for non-Universal Robots brands only. 

 

 
Figure 10 Mounting plate for non-Universal robots. 

  
 

Step 3: Align the holes on the mounting face of the Gecko Gripper with the 
mounting holes on the robot (or mounting plate/custom adapter).  

 



 
Figure 11 The two mounting holes on the mounting face of the gripper. 

  
Insert each mounting screw (M6-1-80) into the front of the gripper, down 
the clearance tube, and use the supplied 5mm hex key to screw into 
place. Tighten each screw to 8 Nm using the 5mm hex key. 

 

 
Figure 12 Tightening the mounting screws to attach the gripper to the robot using the 5mm hex key. 

 



The Gecko Gripper tool center point has no x- or y-axis offset with respect to the 
robot. Therefore, the tool center point is located 185mm (z-axis direction) away 
from the robot arm mounting face.  
See Section 9.1 for detailed gripper dimensions.  

 
You are now ready to wire the mounted gripper (Section 6.3).  

 
 

5.3. Electrical Installation: Powering & Communicating with the Gripper 
 

5.3.1. Power Supply Specifications 
 
The Gecko Gripper itself is powered through the I/O cable. The flying leads on the 
accompanying cable will need to be terminated at the power supply that meets your 
needs. This may include connecting to:  

• 24V DC, 48W (nominal; 28V maximum) external power supply (via included 
barrel connector) 

• The robot controller’s integrated 24V DC power supply 
 

5.3.2. Communications 
 
Depending on your power and communication needs, there are two possible gripper 
cable configurations (that include the autonomous cleaning system): 

• Power and communications using Digital I/O (1 Cable) 

• Power using Digital I/O, Communications via Ethernet TCP/IP (2 Cables) 
 
The optional piezo cleaning system requires an additional 4-pin cable.  

 
Digital I/O 
✓ Communication and 24V power over 10-pin connector (8-pin connector is 

not used for Digital I/O communication, only Ethernet, see below). 
✓ Can be controlled by any type of robot with simple I/O signals. 
✓ Desired set points (e.g. position control spec, force control spec, preload 

spec, etc.) are first set using the Windows Desktop GUI, then the Gripper is 
controlled using the I/O interface. 

✓ No robot software installation is necessary. 
 

You can power the Gecko Gripper in one of two ways using the I/O: 
1. You can plug in barrel jack connector directly to the included power supply.  
2. You can remove the barrel jack connector and use a 24V power supply on 

your preferred robot controller (or another source). The Gecko Gripper 
draws less than 1 Amp (peak and RMS). 

 



The Digital I/O cable is supplied with ports for connecting to the gripper and 
pigtails on the opposite end for direct and customizable wiring as necessary to 
integrate them with your system.  

 

 
Figure 13 Digital I/O cable terminal with barrel jack connector (for  
direct connection to power supply) and other input/output wires. 

For wiring of the I/O channels to their proper connections, see Section 8.1 Digital 
I/O Communications. 
 

Ethernet  
✓ Communication over 8-pin connector. 
✓ Can be controlled by custom Universal Robot, Kawasaki, and FANUC Teach 

Pendant interfaces.  
✓ Can also be controlled with the Windows Desktop GUI by direct Ethernet 

connection between the computer and Gripper. 
 

Ethernet communication allows for dynamic adjustment of the gripper parameters 
whereas in I/O the gripper parameters cannot be dynamically adjusted without the 
Windows Desktop GUI.  

 

5.3.3. Procedure for Powering and Wiring the Gripper  
 
After mounting the gripper to the robot (Section 6.2) and identifying an appropriate 
power supply, you are ready to wire the gripper.  
 
You will need the power and communication cables supplied with the gripper (Turck 
Cable, 10-wire, I/O, and Turck Cable, 8-wire, Ethernet RJ45) as well as several zip ties or 
similar supplies to secure the cables so as not to be disturbed by the robot’s full range of 
motion. 
 



CAUTION  Make sure to check the integrity of the connectors on the gripper base 
as the pins may be easily bent and damaged.  

 
Step 1: Connect the dual Digital I/O and power cable to its connector mate 

located on the gripper base.  
 

 
Figure 14 Connecting the power/digital I/O cable to the matching gripper connector. 

 
Step 2: If using Ethernet communications, attach the Ethernet cable to its 

connector mate located on the gripper base. 
 



 
Figure 15 Attaching the Ethernet cable to the matching connector on the gripper base. 

 
Step 3: Run the cable(s) away from the gripper along the robot to the power 

supply and controller.  
Make sure to leave sufficient cable slack so that the cables are not under 
tension during the robot’s full range of motion.  
 

 
Figure 16 Cables are routed loosely along the robot arm. 

 
Step 4: Secure the cables so that they will remain safely out of the robot and 

substrate’s range of motion. Exercise the robot through all the expected 



motions to ensure that the cables are not damaged during operation (see 
example of rotating J-6 below). 

 

 
Figure 17 Rotating J-6 where the power and communications cables are not damaged by robot motion. 

 
 We recommend the use of zip ties; however, other adhesives or fasteners 

may be better suited for your needs. 
  
NOTICE  Depending on your protocol or operating conditions, you may consider 

adding additional structural or insulating protection to the cables. 
 
 

5.3.4. LEDs Indicate Electrical and Communication States 
 
The Gecko Gripper base has LEDs that provide quick visual information about the status 
of four different states. 
 
The LED indicators and their meanings are shown in the table below: 

LED Name 
and Color 

Steady Color Slow Blink Fast Blink 

Power 
Green 

Power connected N/A N/A 

Error  
Red 

N/A Warning (internal errors); 
Gripper needs 
maintenance; Check error 
logs for details 

Major Error; Gripper should 
be stopped immediately 
and investigated 

Pad 
Orange 

N/A A part has been dropped Parts have been repeatedly 
dropped and error logs 
updated 

Comms 
Blue 

Communications 
connected 

N/A N/A 

Table 3 LED indicators and their meanings. 

 



After connecting the power and wiring the communication cables between gripper and 
its power source and controller, check that the LEDs on the gripper base indicate the 
gripper is functioning nominally: steady green, steady blue, no red or orange lights. 
 

 
Figure 18 LEDs indicate the gripper is functioning nominally  

(steady green Power, steady blue Comms, Error and Pad are off). 

 

5.4. Installation Notes for Different Robots 
 
For additional installation information for different robot brands, visit the OnRobot A/S 
website for the Gecko Gripper: 
 

https://onrobot.com/products/gecko-gripper/ 
  

https://onrobot.com/products/gecko-gripper/


6. Setting the Gripper Parameters 
 
You can create a fully-customized gripping protocol tailored to your protocol specifications 
using the Gecko Gripper GUI. Within the GUI, you may specify gripper preload force and 
ultrasonic range set points and save multiple gripper states for future use. 
  

6.1. Installing the Windows Desktop GUI 
 

OnRobot A/S provides a user-friendly Windows desktop graphical user interface (GUI) for 
the programming and control of the Gecko Gripper via an Ethernet cable.  

 
Recommended Software Requirements: 
✓ Installed Windows 7 with Service Pack 1 or higher (x86 or x64 version) 
✓ Installed .NET Framework 4.7 or higher 
 

6.1.1. Installing the Desktop GUI:  
 

Step 1: Install the application by opening the “Gecko Gripper Desktop GUI setup” file 
from the accompanying OnRobot A/S USB flash drive or from the OnRobot 
A/S website. 

 

 
Figure 19 Beginning the Gecko Gripper GUI installation. 

 



Step 2:  Select the “Launch Gecko Desktop GUI” checkbox when installation 
completes. This will start the application. 

 

 
Figure 20 Launching the Gecko Gripper Desktop GUI after installation. 

You may now start the application at any time by opening the 
“PerceptionRobotics.GeckoWpfClient.exe” from the folder in which it was installed. 
 
Step 3:  Enter the Gecko Gripper’s IP address when prompted by the start screen to 

enable communication to the Gecko Gripper.  

 
Figure 21 Gecko Gripper Start Screen. 



 
You may also change the IP or port configuration under the “Settings” tab in 
the main menu bar. The gripper’s default IP address is 192.168.0.170 and the 
default port number is 30000. 
 

Select the “Save as Default” checkbox to automatically use this IP address for 
the Gecko Gripper the next time the application is opened. 
 

6.2. Setting Up Static IP for the Desktop GUI.  
 
The Gecko Gripper and the Desktop computer must share the same local network in order 
to communicate successfully. The following steps detail how to set up the Desktop IP 
address to pair with that of the Gecko Gripper. 

 
Step 1:  Open Control Panel and click “View network status and tasks.” 

 
Figure 22 Locating network status within the computer's control panel (highlighted in blue). 

 
Step 2: Click “Change adapter settings” on the top-left panel in the window. 



 
Figure 23 Locating the "Change adapter settings" link (underlined blue text). 

 
Step 3: In the next window, right-click on “Ethernet” to reveal a drop-down menu, then 

select “Properties.” 

 
Figure 24 Accessing the Ethernet Properties menu item. 

Step 4: Within the Ethernet Properties pop-up menu, find and select “Internet Protocol 
Version 4 (TCP/IPv4).” When selected, click on the “Properties” button. 



 
Figure 25 Accessing Properties for the Internet Protocol Version 4 (TCP/IPv4) item. 

Step 5: In the resultant pop-up window, select the radio button “Use the following IP 
address.”  

 
 In the box for “IP address,” enter “192.168.0.X,” where X is any integer between 

0-255 other than 170 because “192.168.0.170” is the Gecko Gripper IP address. 
For example, is “192.168.0.3” is a valid IP address for the Desktop GUI which will 
allow communication with the Gecko Gripper (see figure). 

 
In the box for “Subnet mask,” enter “255.255.255.0”. 
 
Leave the “Default gateway” box empty.  
 
Click “OK” to finish assigning the IP address to the Desktop GUI. The GUI is now 
able to locate and connect to the Gecko Gripper. 

 
 



 
Figure 26 Entering a valid IP address for the Desktop GUI. 

6.3. Setting Gripper Parameters Using the Windows Desktop GUI 
 

When a connection to the Gecko Gripper has been successfully established, the Training 
Mode Screen will appear. Note that you can disconnect the Gripper at any time by selecting 
“Disconnect” from the menu bar. 

 



 
Figure 27 Training Mode (Create New State) desktop screen. 

 
 Check that the Gecko Gripper User Interface Software is up to date. The 

software version is listed on the “About” page under “Help” in the main 
menu bar. 

 

 
Figure 28 The “About Dialog” box. 

For information on troubleshooting and support, click on “Support” under 
the “Help” tab in the main menu bar. 



 
 You may configure the desired units (Metric, Imperial, or Percentage) under 

the “Settings” tab on the menu bar. 

 
Figure 29 Changing units within the “Settings” dialog box. 

You are now ready to Verify Gripper Functionality and Configure the Gripper from the 
Desktop. 

 

6.3.1. Create New State: Programming a gripper function for the first time 
Step 1: Open the Gecko Gripper application. The “Training Mode Screen” should 

appear. 

 
Figure 30 Training Mode (Create New State) Desktop screen. 



 

Step 2: Select the appropriate Robot and communication mode from the “Robot” 
drop-down menu in the center-right of the GUI. 

 
Step 3: Set the desired Preload Force.  

This setting modifies at what force level the gripper notifies the robot 
that it has reached a certain load. For example, in picking a large piece of 
glass where 100 N preload force is required, when 100N is reached in I/O 
mode, pin 5 is set HIGH; in Ethernet mode, packet index 9 is set from 0 to 
1.  
For more information on selecting an appropriate preload force for your 
task and material, see Section 9.4.  
 
NOTE: The gecko grippers pre-load sensing range is 30 to 150N, it 
CANNOT sense below 30N 
 

Step 4: Set the Ultrasonic Range.  
Like setting the Preload Force, this setting notifies the robot at which 
range the designated Preload Force is reached. This feature is useful for 
picking flat objects out of a pile as it allows the robot programmer to run 
the robot at maximum speed until the gripper detects that it is 
approaching a pickup point. An example of this use case is described in 
Section 8.1, Step 2. 

  Default ultrasonic range is 125.0mm. 
 

Step 5: Select Pad Position.  
To test basic gripper functionality, the user can try to perform an action 
with each pad position (“Engage” and “Disengage”). 

 Default Pad Position is “Engage.” 
 
Step 6: When you are have completed setting up the new state, select “Perform 

Action” to set the gripper to the state that matches the selected 
parameters.  
These parameters are written to the gripper’s memory. If the gripper is 
run in I/O configuration, it will reference those parameters to set the 
gripper’s state. If the gripper used in Ethernet mode, it will reference 
those parameters as initial state, but they can be dynamically modified.  

 
Step 7: To display real-time gripper force and position data, select “Start Plotting 

Data.” To stop showing data, select “Stop Plotting Data.” 



 
Figure 31 Plotting gripper data within the Desktop GUI. 

Step 8: To view real-time gripper data, including the Parts Presence, Wear, 
Preload Force, and Pad Position, navigate to “View Data” located under 
the “Data” tab on the menu bar. 

 

    
Figure 32 View gripper data within the Desktop GUI. 

 
 

 
Additional Actions: 
  Save Gripper Configuration (see Section 7.3.2) 

Load Existing Gripper Configuration (see Section 7.3.3) 
Reset Gripper (see Section 7.3.4) 
Error Handling (see Section 7.3.5) 
Clean Pads (see Section 7.3.6) 
 

 



6.3.2. Save Gripper Configuration 
 

If you wish to use multiple gripper parameter configurations, it may be useful to 
save individual configurations to a file and access them later. This feature is useful if 
multiple objects are being picked and the robot needs to be re-tasked periodically.  

 
Step 1: Select “File → Save Action to File” from the menu bar. 

 
Choose whether to save state parameters to XML file via dialog box. 

 
Figure 33 Saving an XML file with Gecko Gripper parameters. 

 

6.3.3. Load Configuration: Using an existing or previously saved gripper state 
 
If you have multiple gripper configurations saved, you can load them to quickly set a 
gripper to a previously used state. 
 
Step 1: Select “File → Load Configuration” from the menu bar. 
  An Open File dialog box will appear. 
 



 
Figure 34 Using the Desktop GUI to open an XML file with a previously saved gripper configuration. 

 
Step 2: Select to open a previously saved XML file. 

This will load the Gecko Gripper state settings saved within that file and 
return you to Training Mode (Load State) Screen.  
 

 

Figure 35 Training Mode (Load State) screen with loaded state parameters from a previously saved state. 

 



Step 3: Select “Perform Action” to actuate the gripper to the state loaded in the 
previous step.  

 

6.3.4. Resetting the Gripper  
 
This action resets all changes made to the gripper state parameters since the last 
time they were saved in the associated XML file. If there are no previously saved 
versions, resetting the gripper reverts the gripper parameters to their default values 
(see Section 8). 
 
Step 1: Reach the Training Mode screen from either a New State or after 

selecting Load Existing State. 
 
Step 2: Click the “Reset Gripper” button on the bottom left of the screen. 

 
 

6.3.5. Error Handling 
 
The Gecko Gripper GUI saves detailed information about unexpected events or 
errors during program execution. These error logs can be retrieved from the “Help” 
menu bar by clicking on “Error Logs.” Click “Load Logs” for error log information. The 
error logs can be saved to a file to assist in troubleshooting. To clear all logs on the 
screen, click “Clear All.” Select “Cancel” to return to the Training Mode Screen. 
 

 
Figure 36 Event logging and error details. 

 
 



6.3.6. Clean Pads 
 

The “Clean Pads” feature is used with the optional autonomous piezoelectric 
cleaning system. 
 
See the Piezoelectric Cleaning System Appendix for more information.  

 
  



7. Operating the Gripper 
 
Protocols for operating the gripper will depend largely upon the communication mode: Digital 
I/O or Ethernet TCP. Significantly more information can be conveyed through Ethernet 
communications. Additional operating conditions for specific robot brands can be found in 
appendices located on the OnRobot A/S Gecko Gripper website.  
 
The gripper performs the following major tasks, each of which can be actuated through any 
communication mode:   

• Attaching  

• Detaching 
 

7.1. Digital I/O Communications  
 
This section details how to operate the gripper to perform specific tasks using Digital I/O 
communications. 
 
NOTICE If using Digital I/O communications to operate the gripper, we suggest using 

the Windows Desktop interface. Programming using the Desktop GUI is 
important for exercising all features of gripper. 

 
Step 1: Use the Windows Desktop interface to set up values for the following set points 

(see Section 7 for more details): 

• Preload 

• Ultrasonic Range 

• Pad Position 

• Cleaning Time (if option is installed) 
 

When the gripper is controlled by I/O, its behavior is determined by the 
parameters saved in the gripper’s memory. The gripper parameters are saved to 
memory only when “Perform Action” is selected from the GUI Training Mode 
screen.  In I/O control, the gripper parameters are static, but the gripper’s 
behavior and sensor data can be accessed through I/O control. 

 
Step 2: Use the robot to control the gripper in I/O. The I/O pinout is given in the table 

below: 
 
 
 
 
 
 
 



10-Pin Connector (Power, I/O) 

Pin Color In/Out Gecko Parameter 

1 White IN ENGAGE 

2 Brown IN DISENGAGE 

3 Green OUT ULTRASONIC 

4 Yellow OUT PART 

5 Gray OUT PRELOAD 

6 Pink OUT PAD SERVICE 
(WEAR) 

7 Blue PWR 24VIN 

8 Red PWR GNDIN 

9 Orange OUT ERROR 

10 Tan IN EARTH GROUND 
Figure 37 Pinout for the 10-pin connector. 

 
One can consider the IN/OUT pin assignment as being from the perspective of 
the gripper: for inputs, the gripper expects to receive in a 24V HIGH or LOW 
signal; for outputs, the gripper will send a 24V HIGH or LOW signal to the robot. 

 
Inputs 

ENGAGE (pin 1) 
Use the robot to send a 24V signal to move the pads to Engage position. Note that the 
gripper will only move the pads to the Engage position if the DISENGAGE signal is LOW. 
If both ENGAGE and DISENGAGE signals are HIGH, the pads will not move. 
 
DISENGAGE (pin 2) 
Use the robot to send a 24V signal to move the pads to the Disengage position. Note 
that the gripper will only move the pads to the Disengage position if the ENGAGE signal 
is LOW. If both ENGAGE and DISENGAGE signals are HIGH, the pads will not move. 
 

Outputs 
 

ULTRASONIC (pin 3) 
The ULTRASONIC output will read HIGH if there is a part within a distance less than the 
value set in the Windows GUI. Otherwise it will read LOW as there is no part within the 
specified distance.  
 
Example Use Case: Picking Flat Objects Out of a Stack 
These steps detail how you might use the ULTRASONIC signal to program the gripper to 
pick objects out of a stack.  

1. Use the Windows GUI to set the Ultrasonic Range to 50 mm. 



2. During the robot’s pick-and-place routine, it hovers over the stack. If the 
ULTRASONIC output is LOW, the robot can rapidly approach the stack, as the 
ultrasonic output indicates that the gripper is not within range (50 mm). 

3. When the ULTRASONIC output goes HIGH, the gripper has detected an object 
within 50 mm. The robot should slow down, allowing the Gecko Gripper to do its 
picking action in order to pick an object out of a stack. 

4. The robot completes its pick-and-place motion. The next time the robot picks out 
of the stack, the gripper can dynamically compensate for the change in the height 
of the stack. 

 
PARTS PRESENCE (pin 4) 
The PARTS PRESENCE output will read HIGH if the gripper detects that it has picked up 
an object. It will read LOW if the gripper does not hold an object. This signal can be used 
to confirm that the gripper has correctly picked a part. 
 
If a part is dropped, this will cue an error in the error logs and the “Pad” LED will begin 
to blink (orange) on the gripper itself. 
 
PRELOAD (pin 5) 
The PRELOAD output will read HIGH if the Preload Force exerted by the gripper is 
greater than the value set in the Windows GUI. Otherwise, the PRELOAD output will 
read LOW. The Preload Force exerted by the Gecko Gripper depends how far the robot 
arm moves toward the object.  
 
Example Use Case: Preloading to Pick an Object 
These steps detail how you might use the PRELOAD signal to monitor gripper force on 
the object being picked  

1. Use the Windows GUI to set the Preload to 100 N. 
2. During the robot’s pick-and-place routine, assume the robot approaches 

downwards to apply a preload to pick up the object. While the PRELOAD output is 
LOW, the robot should continue its downwards motion. 

3. When the PRELOAD output goes HIGH, the gripper has reached or exceeded the 
100 N Preload threshold of 100 N. The robot should stop its downwards motion 
as it has applied the desired preload force to pick up the object. 

 
PAD SERVICE (pin 6) 
The PAD SERVICE output (also referred to as “Wear”) will read HIGH when the Gecko 
pads begin to wear. The operator should consider replacing the Gecko pads at this time.  
 
 
ERROR (pin 9) 
The ERROR output will read HIGH whenever an error occurs and is written to the Error 
Log for the gripper. This event will be accompanied by the flashing orange “Error” LED 



on the gripper base. The error log and error codes can be retrieved from the gripper 
through the Windows GUI (see Section 6.3.5). 

 
 

7.2. Ethernet TCP/IP Communications 
 

Controlling the gripper in Ethernet allows for dynamic and complete control of the 
gripper’s parameters. The table below shows the full list of input/output parameters the 
user can control in Ethernet mode. 

 

TCP/IP Parameter IN/OUT Description 

Gripper Mode (Ethernet & 
I/O) 

In Communication mode (Ethernet or I/O) 

Live Data Stream In Enable/disable real-time data readings 

Pad Position 
(Engage/Disengage) 

In Move gecko pads to engage or disengage for pick 
and place 

Save Settings for Gripper I/O In Save current gripper settings to memory for I/O 
control 

Preload Force Spec In Setting for the preload sensor. If the preload 
sensor reads a greater value than this setting, then 
it triggers the preload force I/O output to be HIGH 

Ultrasonic Range Spec In Setting for the ultrasonic sensor. If the ultrasonic 
sensor detects an object is closer than this setting, 

then it triggers the ultrasonic range sensor I/O 
output to be HIGH 

Enable Cleaning In Enable the piezo self-cleaning system (only for 
grippers with the piezo system included) 

Cleaning Time (Single Cycle) In Cleaning time for a single cycle of the piezo self-
cleaning system 

Preload Force Reached  Out Set to HIGH if the preload force is greater than the 
preload force spec, otherwise it is LOW since the 
preload force is less than the preload force spec 

Part Presence Out The parts presence output will read HIGH if the 
gripper detects that it has picked up an object, and 

it will read LOW if the gripper does not have an 
object. 

Wear Out The wear output will read HIGH when the gecko 
pads begin to wear. The operator should consider 
replacing the gecko pads when this output reads 

HIGH. 

Error Detected Out The error output will read HIGH whenever an error 
occurs. This will be accompanied by an orange 

error LED flash, along with an error log written to 



the gripper that can be retrieved via the Windows 
or robot-specific GUI. 

Error Code Out This gives the error code number for the most 
recent error.  

Preload Force Data  Out Gives the current value of the preload force sensor 

Ultrasonic Range Sensor Out Gives the current value of the ultrasonic range 
sensor 

Gripper Mode (Ethernet & 
I/O) 

In Communication mode (Ethernet or I/O) 

Live Data Stream In Enable/disable real-time data readings 
Table 4 Gecko Gripper TCP/IP Parameters 

The gripper can be controlled in Ethernet TCP/IP mode through OnRobot’s robot user 
interfaces, which are supported for Universal Robots, Fanuc, and Kawasaki.  

 
 

7.3. Setting the Tool Center Point  
 
The Gecko Gripper tool center point has no x- or y-axis offset with respect to the robot.  
Therefore, the tool center point is located 185mm (z-axis direction) away from the robot 
arm mounting face (see Section 9.1 for detailed gripper dimensions).  

 
Make sure the plane of the gripper is aligned with the plane of the object being gripped. 
Set the robot’s perch point (yaw, pitch, roll) value to be coplanar with the object’s 
position. 
 
When picking up the object, the gripper should move onto the object until the desired 
preload force is reached or before the pads bottom out, whichever is first. 
 
 

7.4. Operating the Gripper with Robot Collision Detection or Other Safety Systems  
 
When using the Gecko Gripper with a robot in position control, care must be taken 
during the gripping phase of the object as to not trip off the robot’s collision detection 
system.  The most force the gripper will ever need to exert on an object is 150N for 
maximal adhesion.  Based upon your robot type and object, it may be necessary to 
adjust the robot’s collaborative or collision settings to preclude tripping off the robot 
upon contact.   

 
 
 



7.5. Gecko Gripper Use Case: Picking and Placing a Small Solar Panel 

 
When picking and placing an object with the Gecko Gripper, observe the following steps: 

 
Step 1: Prior to picking, drive the robot and gripper to a “perch” position above 

the object.  Ensure the object’s center of gravity is under the center of 
the gripper.  Also ensure the pads of the gripper and the object are 
coplanar, i.e. not tilted. 

 

 
Figure 38 Incorrect (left, center) and correct (right) perch positions. 

 
Step 2: When picking, drive the gripper slowly towards the object (in this case, 

downwards) while ensuring the gripper pads and the object surface are 
coplanar.  

 

 
Figure 39 A visual check that the pads and the surface of the solar panel are coplanar. 

 
Step 3: Contact the object with the gripper and drive in until the desired preload 

force is achieved.  The preload force may be read from the robot 
interface or Windows GUI.   



 
NOTICE Maximum pre-load force for the Gecko Gripper is 150N.  Settings on the 

robot may need to be adjusted to approach this maximum force. 
 

If adequate preload is not of concern (e.g. very low object weight), the 
gripper can be visually guided into contact in position control.  In all 
cases, it is important to ensure the gripper housing does not contact the 
object.  This can damage the object and trip off the robot’s collision 
safeties. 

 

 
Figure 40 Correct (top) and incorrect (bottom) proximity of the gripper  

housing to the object being picked (here, the solar panel). 

 
Step 4: To release the object, follow the specific instructions for your selected 

communication type, either I/O or Ethernet. 
 
If using I/O communications, drive the appropriate I/O channel for 
DISENGAGE to HIGH (for 1 second or less) and then to LOW.  This will 
retract the pads within the gripper. Once the object has been placed, the 



pads should move to ENGAGE by holding the appropriate I/O channel 
HIGH momentarily, then back to LOW to prepare for the next pick.   
 
If using Ethernet communications, the same result can be achieved by 
setting the proper Ethernet packet HIGH or LOW similarly to I/O usage. 
 
Placing the object requires the pads to retract. It is important to note that 
during pad retraction, the object will drop the distance between the 
gripper housing and the surface on which the object is placed. See Section 
9.1 for more details on gripper dimensions.  

 
 
 
  
 
 

  



8. Gecko Gripper Specifications 
 

8.1. Technical Specifications 
 

8.1.1. Gecko Gripper Dimensions 
 

The dimensions of the Gecko Gripper are illustrated below in metric units (mm).  
 

 
Figure 41 Gecko Gripper front and side dimensions. 

 

 
Figure 42 Gecko Gripper gripping face (bottom) dimensions. 



 

 
Figure 43 Gecko Gripper mounting face (top) dimensions. 

 

8.2. Environmental and Operating Conditions 

 
Condition Minimum 

Value 
Optimal 

Value 
Maximal 

Value 
Notes 

Temperature 0C N/A 50C Storage up to 60C 

Surface 
Characteristics 

Matte 
finish 

Highly 
polished 

N/A Smoother surfaces require less 
preload force for a desired 
payload force. 

Table 5 Environmental and operating conditions for the Gecko Gripper. 

 

8.3. Mechanical Specifications 
 

8.3.1. Gripper Specifications 
Specification or Feature Target value 

Maximum Payload (kg) 
          Native Adhesion 
          After Safety Factor (x2) 
          With Cleaning System 

Polished Steel / Acrylic/ Glass/ Sheet Metal  
8.2 / 8.1 / 6.6 / 6.1 
8.2 / 8.1 / 6.6 / 6.1 
1.6 / 1.6 / 1.3 / 1.3 

Gripper Weight 2.4 kg 

Suggested pre-load required for 
max adhesion 

125 N (reduction in preload results in reduction in 
adhesion; see Section 9.4 for more information); 

150 N maximal preload force. 

Detachment time 500 msec 

Certifications 
FCC Part 15 / Canada ISED 

CE - EMC 



IP Rating 54 

Error handling LED and Graphic User Interface 

User Interface 
Teach Pendant (Universal, Kawasaki, Fanuc) 

Windows PC 

Holds part on power loss? Yes 

Communication options 
Digital I/O 

Ethernet TCP (custom protocol) 

Working Temperature 0C - 50C 

Power requirements 
Peak: 24VDC, 0.8 A 
RMS: 24VDC, 0.5 A 

Cable/ Power options 
2 Cables: Power & I/O, Piezo driver (M12) 

3 Cables: Power, Ethernet, Piezo driver (M12) 
Table 6 Gecko Gripper specifications. 

 
8.3.2. Pad Specifications 

 
Specification or Feature Target value 

Parts Presence Sensing Yes (Ultrasonic) 

Pad Material Proprietary silicone blend 

Wear Properties Depends on surface roughness 

Pad Attachment Mechanism Magnetic 

Change-out interval 
100,000 – 200,000 cycles (dependent on 

surface) 

Manual cleaning system Silicone roller 

Manual cleaning interval and % recovery Variable / 100% 
Table 7 Specifications for the Gecko Gripper Pads. 

8.3.3. Preload Sensor Specifications 
 
The preload sensor system is based on piezo-resistive Tekscan sensor technology.  Basal 
sensor data can be located on the Tekscan website (below), but each sensor system is 
calibrated for each gripper. 

 
https://www.tekscan.com/flexiforce-load-force-sensors-and-systems 

 
8.3.4. Ultrasonic Range Sensor 

 
Range and parts presence sensing is based on ultrasonic sensing technology. Further 
information can be found here: 
 

https://cdn.automationdirect.com/static/specs/prox18mmultrauk6.pdf 
 
 

https://www.tekscan.com/flexiforce-load-force-sensors-and-systems
https://cdn.automationdirect.com/static/specs/prox18mmultrauk6.pdf


8.4. Selecting an Appropriate Preload Force 
 

Selecting an appropriate preload force is essential for optimal gripper operation and 
depends heavily on the details of your specific application. For example, substrate 
material, robot-object movements, and environmental conditions will all impact the 
amount of preload force that is necessary. 

 
8.4.1. Adhesion Strength Increases with Preload Force (Dependent on Material) 
 
The Gecko Gripper works best with highly polished surfaces that allow for maximal 
contact between the adhesive pads and the substrate surface. As the surface becomes 
less smooth, more preload force is required to grip substrates. Matte surfaces should be 
considered the maximal surface roughness limit which the gripper is able to grip.  
 

 
Figure 44 Payload force for a given preload force is dependent on the smoothness or roughness of the substrate. 

Adhesion specifications assume that the center of gravity of the object is equidistant 
from the gripper pads. If the center of gravity of the object is not centered or 
moments are applied to the object, this can decrease the adhesion force of the gripper 
causing it to drop the objects. 
 



The optimal preload force for your application will depend on the surface roughness of 
the object and should be experimentally determined under your specific operating 
conditions. 
 
Flexible materials, so long as they are smooth and rigid in shear (non-stretching), can 
also be picked up by the Gecko Gripper (e.g. aluminum foil and plastic wrap). The 
preload force required to pick up these materials depends on both the surface 
roughness and the rigidity of the backing/support on which those surfaces are held. The 
optimal preload force should be determined experimentally.  
 

 

8.5. Pick Location and Limits of Payload Movement 
 
Users will also need to account for G-forces or other forces that act on the picked part 
that could potentially overcome the gripping force of the Gecko Gripper. Applying a 
moment to the object can result in peeling of the object from the pads and possible 
dropping of the object. This problem is magnified as the footprint of the object greatly 
exceeds the footprint of the gripper. 
 

  



9. Gripper Maintenance 
 

9.1. Maintenance Overview and Schedule 
 

Gecko Gripper pads are made from a precision cast silicone or polyurethane film with a 
gecko microstructure. Contact with sharp objects may damage the pad surface and 
impair function. The Gecko Gripper performance is maximized when the pads are clean 
and dry.  The pads can collect dust, so it is best to use the Gecko Gripper in a clean 
environment and/or establish a routine cleaning schedule. 

 
 
 
 
 
 
 
 
 
 
 
 
 

9.2. Cleaning the Gripper Pads 
 

To clean the pads manually, inspect the pads and use the provided tacky roller to 
remove surface dust or debris.  Pads should be cleaned every 10,000 cycles as a baseline 
and adjusted based on the environment. 
 

 
Figure 45 Manually cleaning the gripper pads with the tacky roller. 

Part Description of Maintenance Frequency 

Pads  Routine cleaning: 
 

• Manual – Tacky Roller  

• Programmed – Cleaning 
Station 

 
 
Replacement: 

Dependent on operating 
conditions. Guidelines are: 

• Every 10,000 cycles in ISO 
9 environment (but will 
ultimately depend on 
individual conditions). 

 
Every 100,000-200,000 cycles 
(depending on environment) 

Connectors Replacement due to bent pins As needed 



9.3. Replacing the Gripper Pads 
 

Gecko Gripper pads are designed to last for 100,000-200,000 cycles under typical 
operating conditions. If the pads do not seem to be gripping properly, even with routine 
cleaning (see Section 10.2), we recommend fully replacing the gripper pads. 
 

 
Figure 46: Notional drop in adhesion due to pad wear 

 
 
To replace the gripper pads, use the provided pad removal tool. 
 
Step 1: Move gripper pads to the maximum extruded setting such that the pads 

are maximally exposed/visible. 
 



 
Figure 477 Gecko Gripper pads in their maximally extruded position and the pad removal tool. 

 
Step 2: Insert the edge of the pad removal tool between the shiny silver plate of 

the pads and the dull backing plate. Leverage the pad removal tool 
against the gripper housing to pry off the used pad. Repeat for all pads. 

 

 
Figure 48 Leveraging the pad removal tool to replace worn pads. 

Step 3: To install new replacement pads, align the notch of the pad with the tab 
in the mounting hole. Push the pad into the gripper until there are no 
gaps between the shiny silver pad plate and backing plate. 



 

 
Figure 489 Installing new replacement pads by aligning the notch 

 of the mounting plate with the tab of the replacement pad. 

10. Troubleshooting  
 

10.1. Error Handling   
 
Unexpected events and errors are recorded by the gripper program during a run and can be 
saved to either a local file if running the Desktop GUI (see Section 6.3.5 on Error Handling.) 

 

10.2. LED States   
 

There are status LEDs on the gripper for power (“Power”), general error (“Error”), pad state 
(“Pads”), and communication (“Comms”).  The LED indicators and their meanings are shown 
in the table below: 
 
 
 
 
 
 
 
 
 
 



LED Name 
and Color 

Steady Color Slow Blink Fast Blink 

Power 
Green 

Power connected N/A N/A 

Error  
Red 

N/A Warning (internal errors); 
Gripper needs 
maintenance; Check error 
logs for details 

Major Error; Gripper should 
be stopped immediately 
and investigated 

Pad 
Orange 

N/A A part has been dropped Parts have been repeatedly 
dropped and error logs 
updated 

Comms 
Blue 

Communications 
connected 

N/A N/A 

Table 8 LED indicators and their meanings. 

 

11. Warranty  
 
Please see OnRobot A/S website for Warranty information or email info@onrobot.com  
 

12. Contact  
 

OnRobot A/S  
Teglvaerksvej 47H  
5220 Odense, Denmark  
info@onrobot.com  
 

13. Declarations and Certifications 
 

- Immunity:  

o EN 61000-6-2 with C1: Heavy Industrial 

- Emissions: 

o EN 55011 with A1: Heavy Industrial 

o FCC Part 15 / Canada ISED 

- IP-42 

- Components ROHS and UL Compliant 
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